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Overview 

Introduction 
Put the Sound of a Symphony on Your Desktop 
Symphony Desktop for Mac, iPad Pro and Windows offers the legendary sound quality of Apogee’s 
flagship Symphony I/O Mk II into an elegant 10x10 audio interface that sits on your desk and fits in 
your bag. With Symphony Desktop, musicians and producers are empowered to record, overdub and 
mix with the music industry’s most respected AD/DA convertors and mic preamps.  
 
By combining superior performance with new features like mic preamp emulation, the Symphony ECS 
Channel Strip and Clearmountain’s Spaces reverb plugins, and ultra low latency recording with 
hardware DSP and Apogee native FX plugins, Symphony Desktop will amplify your creativity in the 
studio or on the go, giving your recordings the Apogee quality advantage. 

Features 
Symphony Analog-to-Digital Conversion 
Similar to Symphony I/O MkII, Symphony Desktop’s analog-to-digital converter stage features 
ultra-low distortion, high-slew rate, fully differential analog op-amps plus a cutting edge A/D converter 
in a performance-enhancing dual-sum configuration. Create with the confidence that every nuance of 
your analog input is faithfully reproduced in the digital domain.  
 
Symphony Digital-to-Analog Conversion 
Symphony Desktop’s digital-to-analog stage employs brand new technology to provide 
uncompromising Symphony DAC performance in a portable product, including a robust ultra-low 
distortion, high-current output driver. Regardless of downstream connections, Symphony Desktop 
provides a transparent, widescreen window into the sonic landscape of your mix. 
 
Immersive Touch screen 
The immersive TFT touch screen and responsive Control knob gives you total control over all aspects 
of Symphony Desktop, from input and output levels, mic preamp emulation, low latency mixers and 
routing. With everything at your fingertips, your music creation and production flows freely, whether 
you’re on a Mac, Windows or iOS platform. 
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Apogee Alloy Mic Preamp Emulation 
Apogee Alloy mic preamp emulation offers analog circuitry plus DSP processing to create the richest, 
most authentic audio modeling available in an audio interface. Critical aspects of the model such as 
input impedance, transient profile and distortion characteristics are first implemented in the analog 
domain, followed by precise and accurate refinement in DSP, for a hybrid result that’s greater than 
the sum of its parts. 
 
The AP-66 emulation is based on the Class A solid-state Neve 1066 mic preamp, with a characteristic 
low-mid color and slightly compressed transients. 
 
The AP-57 emulation offers  the lush, larger-than-life tube saturation of a carefully restored 50s era 
Ampex 601 preamp. 
 
Innovative Workflows with Hardware DSP 
Symphony Desktop includes flexible and powerful onboard DSP processing that supports a wide 
range of innovative workflows, using the Apogee Channel FX plugin. Whether you’re printing your 
tracks with Apogee Alloy mic preamp emulation or enjoying the benefits of DualPath monitoring, 
there’s a DSP-powered workflow that fits you like a glove. 
 
Apogee Plugins Included 
Included with Symphony Desktop is the Symphony ECS Channel Strip plugin. Tuned by Bob 
Clearmountain, Symphony ECS includes EQ, Compression and Saturation for quick and effective 
processing when tracking vocals or acoustic instruments. 
 
Also included is the Apogee Clearmountain’s Spaces plugin, which reproduces legendary mixer Bob 
Clearmountain’s personalized workflow for creating the distinctive, rich spaces where his mixes live. 
With the very same echo chamber profiles and processing he’s used on countless hit records, 
Clearmountain’s Spaces lets you envelope your tracks in unique and cohesive atmospheres that set 
your mixes apart. 
 
Zero-Ohm Headphone Outputs 
Symphony Desktop has two completely independent ultra low impedance headphone outputs that are 
individually routable, equipped with dual-sum ESS DACs. Output power range is tailored to the 
expected type of headphones: the front panel output can drive virtually any headphones, while the 
rear panel output is specifically designed for high-efficiency headphones. 
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Advanced Stepped Gain Mic Preamps 
At the core of the input stage, Symphony Desktop’s mic preamps offer up to 75dB of gain. The 
preamp design features Apogee’s unique Advanced Stepped Gain Architecture to ensure ultra-low 
noise and distortion regardless of the source, from pounding kick drum to delicate fingerpicking on an 
acoustic guitar. With variable impedance settings on both mic and instrument inputs, Symphony 
Desktop optimizes the input stage to better match your specific devices, for deep lows and clear 
highs. Selectable mic preamp emulation adds character, attitude and a bit of grit to your recordings.  
 
Apple Logic Pro Integration 
Logic Pro X users enjoy the ultimate Apogee Channel FX and DualPath Monitoring experience, 
thanks to unique hardware-software integration features, such as the Logic Pro X Direct button and 
Audio Device Control view. And, it can all be controlled from a single window in Logic, no need for an 
additional mixer or console app. 
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Navigating This User’s Guide 
A computer-based audio production system built around the Symphony Desktop includes the 
following components: 
 

● Symphony Desktop Hardware Interface 

● Apogee Desktop Control software application 

● Apogee Channel FX plus Apogee FX plugins 

● Mac, Windows or iOS device plus a Digital audio workstation (DAW) software application 

● Microphones and Instruments for recording plus speakers and headphones for listening 

 
This User’s Guide will take you through the following steps to integrate the components of your 
system into a powerful and efficient audio production environment. When text is highlighted in ​blue​, it 
may be clicked to link to further information in this Guide. 
 

● Download and run the Symphony Desktop Installer, which installs the Apogee Desktop 

Control application (and driver if required) on your computer (​link​). 

● Connect Symphony Desktop to AC power (required) and to your computer via USB (​link​). 

● Update Touch Screen Control using the included USB thumb drive (​link​). 

● Configure your computer’s operating system (OS) to use Symphony Desktop for audio input 

and output (​link​). 

● Configure your DAW to use Symphony Desktop for audio input and output ​(link​). 

● Connect microphones, instruments, headphones, speakers and other audio hardware to 

Symphony Desktop (​link​). 

● Use Symphony Desktop’s top panel TFT touch screen to navigate Input, Output and most 

System settings (​link​). 

● Use  Desktop Control software to navigate all settings, including direct monitor mixing and 

Apogee Channel FX (​link​). 

● Choose a Monitoring workflow and configure your DAW and Symphony Desktop (​link​). 

● Set up Plugin Processing workflows according to your preference (​link​). 

 

See the Apogee FX User’s Guide (included in the Symphony Desktop Installer download) for 

information about the Apogee  Channel FX and plugins, including the Symphony ECS Channel Strip. 

 

See the Clearmountain’s Spaces User’s Guide (included in the Symphony Desktop Installer 

download) for information about the Clearmountain’s Spaces plugin. 
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In the Box 
● Symphony Desktop 
● Universal Power Supply with US (North America), UK, EU and SAA AC connector. 
● USB-C > USB-C & USB-C > USB-A cables 
● 1Gb USB thumb drive for Touch screen Control updates 
● Quick Start Guide 
● Warranty Booklet 

 

System Requirements 
● macOS 10.13 or greater 
● Windows 10 Anniversary update or later 
● iOS 13 or greater 
● Mac & Windows: 4GB minimum RAM, 8GB Recommended 

 
 

Register your Product 
● Access Apogee’s expert Technical Support for free 
● Receive important product update information by email 
● Take the Customer Satisfaction Survey for a chance to win Apogee gear! 
 
Register Now:​ ​www.apogeedigital.com/support/register 
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Symphony Desktop Panel Tour 
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Getting Started 

Installing Apogee Desktop Software  
To register your product and receive the Symphony Desktop Installer, learn the most up-to-date 
information on new releases, and view Interactive tutorials, click the link below. 
 

www.apogeedigital.com/support/symphonydesktop 
 

Once you’ve registered your Symphony Desktop, you’ll receive an email with links to Mac and 
Windows versions of the Symphony Desktop Installer download.  

macOS Installer 
Once downloaded, double-click the .dmg file to display the contents: 

● Desktop Control Software Installer 
● SymphonyDesktopUpdate file  
● Documentation for Symphony Desktop & Apogee plugins 
● Symphony Desktop Uninstaller 

 
To install Desktop Control Software: 
1. Double-click the Desktop Control Software installer.  
2. A dialog box will appear with a series of steps to complete the installation.  
3. By default, all Apogee plugins are installed in all formats. Even if you don’t have an iLok license 

for a plugin, you can try it for a limited time. You can customize what plugins and formats are 
installed in the Plugins step. 

4. You will be required to restart your computer. 
 

Windows 10 Installer 
1. In your Downloads folder, double-click the 

.zip file to extract it, then double-click the 

.exe file to start the installation process. 
2. By default, all Apogee plugins and 

documentation are installed, In the Select 
Components window, you can de-select 
plugins and/or plugin formats you don’t 
want to install. 
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3. Click Next through all steps, then click 

Finish at the final step. 
4. You should restart your computer 

immediately. 
5. The User’s Guides are installed on your 

computer’s desktop. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

iPad Pro/iPhone 
 
There is no software to be installed when using Symphony Desktop with an iPad Pro or other iOS 
device like your iPhone. All Desktop settings are accessed from the touch screen. 
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Connecting Symphony Desktop 

AC Power 
1. Connect the supplied Universal power supply to your AC (wall) outlet. 
 

● For Type A-compatible outlets (North America) - Flip 
down the connector blades. 

 
 
 
 
 

● For Type C,G or I- compatible outlets (UK, EU & SAA) - 
Slide the adaptor down over the closed connector 
blades. 

 
 
 
 
 
 
 
 
2. IMPORTANT, READ CAREFULLY- Symphony Desktop’s 

DC connection includes a locking mechanism. Line up the 
locking tabs on the cable barrel connector with the locking 
slots on the rear panel DC socket. 

3. Insert the barrel connector until it is flush against the socket, 
then turn clockwise until it stops. 

4. Lightly tug the connector to ensure it’s locked in place. 
5. Tap the Control Knob to power up Symphony Desktop - the 

touch screen will flash for for approximately 30 seconds as 
the internal processor starts. 
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Connecting to a Mac or Windows computer 
 
Using one of the supplied cables (USB-C to USB-C or 
USB-C to USB-A), connect Symphony Desktop’s  USB-C 
port to a USB port on your Mac or Windows computer. 
 
Be sure to use Symphony Desktop’s USB-C port, not the 
port labelled USB Host.  
 
 

 

Connecting to an iPad Pro (USB-C) 
Using the supplied USB-C to USB-C, connect Symphony Desktop’s USB-C port to the iPad Pro’s 
USB-C connector.  

Connecting to an iOS Device 
Using one of the supplied cables (USB-C to USB-C or USB-C to USB-A), connect Symphony 
Desktop’s USB-C port to an Apple Camera Connection Kit, supplied separately. The Camera kit’s 
Lightning connector is then connected to your iOS device.  
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Update Touch Screen Control 
Please note ​- Before using Symphony Desktop, it’s necessary to update Touch Screen Control, using 
the supplied USB thumb drive. If you don’t have the supplied thumb drive, any USB thumb drive 
formatted in the FAT32 format will work. See below for formatting instructions on Mac & Windows. 
 
1. Connect the supplied USB thumb drive to your computer. To connect to a USB-C port, use a 

USB-A to USB-C adapter. 
2. On macOS - Double-click the Symphony Desktop Installer to open it, then drag the 

SymphonyDesktopUpdate folder into the USB thumb drive. 
3. On Windows 10 - In your Downloads folder, double-click the SymphonyDesktopInstaller.zip to 

extract the contents, then drag the SymphonyDesktopUpdate folder into the USB thumb drive 
4. Eject the thumb drive from your computer, then connect the thumb drive to the Symphony 

Desktop rear panel USB Host connector. 
 
5. On the Symphony Desktop touch screen, tap the 

gear icon to open System Settings, then swipe right 
to page 3 (page 2 in early versions). 

6. Tap the Update (labelled Firmware in early versions) 
button, then tap Check for Update. 

7. Tap Yes to the Update? query, tap Yes again to the 
Proceed? query. 

 
 
 
 
8. The Touch Screen Control update will start as 

indicated by a progress bar. Do NOT power 
Symphony Desktop off or remove the power 
connection. 

 
9. Once the Touch Screen Control update is complete, 

Symphony Desktop will automatically power cycle. It 
is now ready for use. 
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To use your own USB thumb drive, it must be formatted to the FAT32 file system. 
 
1. On macOS: 

● Connect your USB drive to your computer, 
then open Disk Utility from the Applications > 
Utilities folder. 

● In the menu bar, select View > Show All 
Devices. 

● In the left hand External column, click the 
USB thumb drive Root Device (i.e the 
volume representing the thumb drive that’s 
higher and to the left). 

● In the upper Toolbar, click the Erase button. 
● Enter a name, set the Format to MS-DOS (FAT), set the Scheme to Master Boot Record, then 

click Erase. 
 
 
 

2. On Windows 10: 
● Open File Explorer. 
● Right-click on the USB thumb drive and 

choose Format. 
● Set File System to FAT32 and click Start. 
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Configure OS to use Symphony Desktop for Audio I/O 

macOS 
To choose Symphony Desktop as the audio interface for Mac applications that don’t have specific               
audio hardware preferences, such as Safari, Spotify, Voice Memos and others: 
 
1. Open System Preferences by choosing     

Apple menu > System Preferences. 
2. Click the Sound icon to open the Sound        

preferences panel. 
3. Click the Output tab, then click on       

Symphony Desktop in the devices list. 
4. Click the Input tab, then click on       

Symphony Desktop in the devices list. 

 

 

Windows 10 
To choose Symphony Desktop as the audio interface for Windows          
applications that don’t have specific audio hardware preferences,        
such as Google Chrome, Spotify, and others: 
 
1. Type Control Panel in the Windows search bar to open the           

Control Panel. Double-click the Sound icon. 
2. Click the Playback tab and select Speakers-Symphony Desktop. 
3. Click Properties, then click the Advanced tab. 
4. Uncheck Exclusive Mode checkboxes. When using a DAW and         

apps like Spotify simultaneously, match the Default Format        
sample rate with the rate of the DAW session. 

5. Click Apply. 
6. Click the Recording tab and repeat steps 2-5 
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Apple iOS 
 
Apple iOS automatically chooses the most recently connected audio interface as the audio I/O device 
for all applications. Simply connect Symphony Desktop to your iOS device’s Lightning or USB-C port 
as described ​here​. 
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Connecting Your Studio 
A wide range of devices, including dynamic & condenser microphones, electric instruments, 
speakers, headphones, and digital I/O expanders may be connected to Symphony Desktop. 
 
 

 
 
 

1. Connect microphones and line level audio gear to the rear panel XLR inputs. 
● Connect dynamic and condenser mics to XLR inputs, then set Analog Level to Mic from the 

touch screen (​link​) or Desktop Control (​link​). When using condenser mics, be sure to engage 
48v phantom power. 

● Connect analog line level audio gear line outputs to the XLR inputs using the appropriate 
adaptor if required. Set Analog Level to +4 dBu for professional sources, set to -10dBV for 
consumer level sources. 

2. Connect synthesizers and keyboards to the rear panel ¼” inputs 1 & 2, then set Analog Level to 
Instrument from the touch screen or Desktop Control. 
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3. Connect consumer headphones, earbuds and balanced armature headphones (with 
comparatively low impedance and higher sensitivity) to the rear panel ⅛” headphone output. 

4. Connect Main outputs 1-2 directly to active speakers. If your speakers are equipped with XLR 
inputs, use a ¼” TRS (tip-ring-sleeve) to XLR male adaptor cable. If using passive speakers, 
connect the Main outputs to the speaker’s amplifier inputs. 

5. Connect to your Mac, Windows or iOS device to the USB-C  port. 
 
 

 
 
6. Connect electric guitars and basses to the front panel ¼” input. Once the ¼” connector is inserted, 

Input 2 Analog Level automatically toggles to Instrument.  
 

Important Note - ​When connections are made to ​both ​the rear panel analog input 2 (XLR or 
TRS) and the front panel Instrument input, the rear panel connection takes precedence. To 
use the front panel instrument input, disconnect the rear panel connection. 

 
7. Connect professional headphones (with a comparatively higher impedance and lower sensitivity) 

to the front panel ¼” headphone output.  
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8. Connect audio gear equipped with optical outputs only (such as mic preamp expanders, CD 

players, and other hi-fi devices) to the rear panel Optical input. Thanks to transparent sample rate 
conversion on the optical input, there’s no need to clock one device to the other - both may 
remain set to Internal clock.  
● Set Symphony Desktop Optical format to match that of the connected device from the touch 

screen (​link​) or Desktop Control (​link​). 
 

 
 
9. For bi-directional streaming of digital audio between Symphony Desktop and Symphony IO MkII, 

interconnect Optical I/O between each interface.  
● Set Symphony Desktop and Symphony I/O MkII Optical format to ADAT or SMUX (depending 

on sample rate). 
● Set Symphony I/O MkII Clock source to Optical. 
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Standalone Operation 
Symphony Desktop may be used standalone (i.e not connected to a computer) with any digital audio 
device equipped with S/PDIF or ADAT/SMUX optical I/O. 
 
To configure for standalone operation, make the following settings from the touch screen: 
 
1. Connect Symphony Desktop Optical output to the device’s Optical in; connect the device’s Optical 

out to Desktop’s Optical in (as shown in figure 9). 
2. In Touch Screen Control: 

● Set Optical outputs 1-2 Routing to HW Inputs > Analog Inputs 1-2. 
● Set the Main, HP1, and HP2 outputs to Direct HW Inputs > Optical In 1-2. 
● See ​here​ for further details on Routing 

3. Set the connected device’s clock source to Optical. 
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TFT Touch Screen Control 
The immersive Touch Screen Control and responsive Control knob gives you total control over all 
aspects of Symphony Desktop, from input and output levels, mic preamp emulation, Direct monitoring 
mixers and routing. 

Navigating the Touch screen Interface 
 
The touch screen interface consists of three primary views - Input/Output, Mixer, and System              
Settings, accessible by tapping the icons indicated below. Once a primary view is selected, additional               
settings are accessed by tapping displayed buttons and swiping left <> right between views. 
 
 

 
 
 
 
The Input/Output (I/O) view provides I/O metering, sample rate indication, connection status, and             
analog I/O parameters. 
 
1. The five circular I/O buttons at the bottom of the I/O view display level settings for Symphony                 

Desktop’s analog inputs and outputs.  
● To quickly modify level settings, tap an I/O button to highlight it with an orange focus ring - this                   

assigns the Control knob to that button. Turn the Control knob to increase or decrease the                
level. 

● Tap the highlighted button repeatedly to toggle through Overview and Settings screens for the              
selected input/output and the I/O View. You can also swipe left <> right to navigate through                
the views.  
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I/O View                           Input 1 Overview                        Input 1 Settings 

 
2. In the upper right hand corner of the touch screen, the hardware sample rate and current USB                 

connection status are displayed. 
 
The Mixer view provides access to Symphony Desktop’s two Direct monitoring mixers. 
 

 
 
1. Tap the Mixer icon repeatedly to toggle between the two Direct mixers. You can also swipe L<>R                 

between the mixers. 
2. Four square Channel buttons at the bottom of the Mixer views provide access to settings for the                 

Analog, Optical, Playback and Master Out channels.  
● Tap a Channel button repeatedly to toggle through Channel Settings views for a specific type               

of channel - for example, tapping the Analog Channel button toggles between Analog IN 1 and                
Analog IN 2 Channel Settings views. You can also swipe through the views. 
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The System Settings views provide complete I/O routing plus system level settings. 
 

 
 

● Swipe left <> right to navigate through the 3 System Settings views. 
 

All I/O, Mixer and System Settings views are described in greater detail below. 
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I/O Views 
Input 1-2 Overview 
The Input 1-2 Overview has 3 different presentations, based on the Preamp setting: SD-MP, AP-66               
and AP-57.  
  
1. Input Gain - tap to set the gain of the preamp           

with the Control knob, when Analog Level is        
set to Mic or Instrument. Gain Control is        
hidden when Analog Level is set to +4dBu or         
-10 dBV line input. 

2. Digital meter - displays the digital level after        
A/D conversion 

3. Lo-Z Impedance - (AP-66 only) set the       
impedance of the mic preamp to low (300        
ohms) when using low impedance mics, such       
as certain ribbon mics. 

4. Output level - (AP-66, AP-57 only) tap to set         
the output level of the mic preamp stage.  

5. GL - Gain link - (AP-66, AP-57 only) link the          
Input gain to the Output level so increasing        
the Input gain reduces the Output level to        
maintain a consistent signal level. This is       
useful when driving the mic preamp emulation       
into distortion. 

6. -20 db Pad - (AP-57 only) decreases the        
sensitivity of the analog input by 20 dB.        
Engage the -20 dB pad when gain is set to 0           
but the input is still overloading. 
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Input 1-2 Settings  
 

1. Analog Level - choose the analog reference       
level for Analog inputs 1-2. 
● Choose ​Mic when connecting    

microphones or direct boxes to the XLR       
input. 

● Choose ​Inst when connecting a guitar,      
keyboard, or any high impedance (Hi-Z)      
instrument to the 1/4” input (balanced      
TRS or unbalanced TS).  

● Choose ​+4dBu when connecting “pro”     
gear with a nominal +4 dBu output level        
(such as an external mic pre, compressor, or EQ) to the XLR input. 

● Choose ​-10dBV when connecting “semi-pro”, hi-fi, or musical instrument gear with a nominal             
-10dBV dBu output level to the XLR input. 

2. Preamp - select the mic preamp: 
● SD-MP - Symphony mic pre with no emulation processing and a gain range of 0-75 dB. 
● AP-66 - based on a vintage Neve 1066 mic preamp section with a gain range of 20-80 dB. 
● AP-57 - based on a highly modified Ampex tube mic preamp with a gain range of 0-10. 

3. Monitor FX On/Off & Preset Select - Enable Apogee Channel FX processing in the Monitor path                
(through the Control app direct monitoring mixer), and select a preset. 

4. Print FX On/Off & Preset Select - Enable Apogee Channel FX processing in the Record path (to                 
audio software) and select a preset. 

5. Input Settings 
● 48V - enable 48 volt phantom power on each analog input when Analog Level is set to Mic.                  

Most condenser mics require 48 volt phantom power to operate. 
● Group - Link the Input Gain (plus Output Level and Gain Link button when present) of each                 

analog input. Any level offsets that exists before inputs are grouped will be preserved after a                
group is chosen. 

● Soft Limit - engage Soft Limit on each analog input. Soft Limit is an analog circuit that begins 
to attenuate transient peaks at a threshold of -4dBfs, replicating the transient softening of 
analog tape. 

● Polarity Invert - invert the polarity of the analog input signal.  
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Main Out Overview 
 
1. Level - set the level of Main outputs 1-2; 
2. Source Meter - displays the digital level of the         

Main output source, before D/A conversion; 
3. Main Out parameters: 

● Mute - mute the Main outputs 1-2. 
● Dim - dim (reduce) the Main output 1-2        

level by 15 dB. 
● Sum to Mono - sum to mono the Main         

outputs. 

 
Main Out Settings 
 
1. Assignment - choose the signal source for       

Main outputs 1-2; 
● SW Playback - route the selected stereo       

Playback signal from audio software to      
the Main output. 

● Direct Mixers - route the stereo signal       
from the selected mixer to the Main       
output. 

● HW:Inputs - route the selected mono or       
stereo signal from the selected hardware      
input(s) to the Main output. 

2. Main Out Format - set the Main output format; 
● Variable - use the Control knob or software volume controls to modify the Main output level.  
● Fixed - the Main output level is fixed at the selected reference level. 

3. Main Out Level - set the Main output reference level: 
● +4dBu - set the reference level to +4 dBu when connecting to professional gear. 
● -10 dBV - set the reference level to -10 dBV when connecting to consumer gear. 

4. Main Out parameters: 
● Mute - mute the Main outputs 1-2. 
● Dim - dim (reduce) the Main output 1-2 level by 15 dB. 
● Sum to Mono - sum to mono the Main outputs. 
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Headphone Out 1-2 Overview 
 
1. Level - displays the level of the headphone        

output: 
● HP1 = front panel output. 
● HP2 = rear panel output. 

2. Source Meter - displays the digital level of        
the HP output source, before D/A conversion. 

3. Main Out parameters: 
● Mute - mute the Main outputs 1-2. 
● Dim - dim (reduce) the Main output 1-2        

level by 15 dB. 
● Sum to Mono - sum to mono the Main outputs. 

 
Headphone Out 1-2 Settings 
 
1. Assignment - choose the signal source for       

the headphone output; 
● Follow Main -  
● SW:Playbacks - route the selected stereo      

Playback signal from audio software to      
the HP output. 

● Direct:Mixers - route the stereo signal      
from the selected mixer to the HP output. 

● Direct:HW Inputs - route the selected      
mono or stereo signal from the selected       
hardware input(s) to the HP output. 

2. HP 1-2 parameters: 
● Mute - mute the HP1 or HP2  outputs. 
● Dim - dim (reduce) the HP1 or HP2  output level by 15 dB. 
● Sum to Mono - sum to mono the HP1 or HP2  outputs. 
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Mixer Views 
Mixer Overview 

 

 
 
 
1. Tap the Mixer icon repeatedly to toggle between the two Direct mixers. You can also swipe L<>R                 

between the mixers. 
2. Tap repeatedly or swipe to toggle between Analog IN Channel settings views. 
3. Tap repeatedly or swipe to toggle between Optical IN Channel settings views. 
4. Tap repeatedly or swipe to toggle between Playback Channel settings views. 
5. Tap to display the Mixer Master settings view. 
 
Channel Settings 
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1. Input meter (mono or stereo) - displays the digital signal level of the channel. The Analog IN 
channel levels are post A/D conversion. 

2. Stereo Link - tap to toggle the channel between mono and stereo.  Playback channels are always 
stereo linked, so no button appears. 

3. Channel fader  - Set the level of the channel signal in the Mixer Master stereo output. 
4. Channel pan control - Set the left-right placement of the channel signal in the Mixer Master stereo                 

output. Stereo  
5. Mute - Mute the signal to the mixer stereo output.  
6. Solo - Solo the channel - all other channels are muted (unless their Solo button is engaged). 

System Settings Views 
Page 1 - Routing 
To configure routing for each stereo analog and digital output pair: 
 
Tap an output button, then choose a source from 
the nested menu. 

● SW:Playbacks - route the selected stereo      
Playback signal from audio software to      
the output. 

● Direct:Mixers - route the stereo signal      
from the selected mixer to the output. 

● Direct:HW Inputs - route the selected      
mono or stereo signal from the selected       
hardware input(s) to the output. 

● Follow Main - Headphone 1 & 2 Output        
only - when a headphone output is set to Follow Main, the audio signal routed to that output is                   
determined by the Main Out Routing setting. 

 
For example, to route the Direct Mixer 1 to the Main Out and Headphone 1 while routing Playback 3-4                   
to Headphone 2: 
 
1. Tap Headphone 1, then tap Follow. 
2. Tap Main Out, then tap Direct:Mixers > Mixer 1. 
3. Tap Headphone 2, then tap SW:Playbacks > Playback 3-4. 
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Page 2 

 
 
1. Optical Meters - tap to show or hide Optical I/O level meters on the I/O View. 
2. Optical Format - tap to set the Optical I/O digital format: 

● S/PDIF - 2 channel format at sample rates of 44.1-96kHz. 
● ADAT - 8 channel format at sample rates  of 44.1-48 kHz. 
● SMUX - 4 channel format at sample rates of 88.2-96kHz. 

3. Controller - set the behavior of the top panel Control knob when tapped: 
● None - nothing happens when tapping the Control knob. 
● Mute All Outs - mutes the Main, HP1 and HP2 outputs. 
● Mute Main Outs - mutes the Main outputs only. 
● Mute HP1 - mutes the front headphone output only. 
● Mute HP2 - mutes the rear headphone output only. 
● Toggle Mute HP/Speaker - toggle between Main outs muted/headphones unmuted and Main            

outs unmuted and headphone muted. Great when you’re tracking in the control room and want               
to listen to playback over speakers. 

● Toggle I/O Selections - Toggle the Control knob assignment through the two inputs and three               
outputs. 

4. Peak Hold - tap to set the time* that peak indicators are held on the level meters. 
5. Over Hold - tap to set the time* that over indicators are held on the level meters. 
 
* Infinite hold time not guaranteed. 
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Page 3 

 
 
 
1. Sleep Timer - tap to set the time that, if untouched, the touch screen enters sleep mode. 
2. Display Brightness - set the brightness of the touch screen. 
3. Sample Rate 

● When Symphony Desktop is connected to a computer or iPad, the sample rate is a read-only                
indicator of the current sample rate. 

● When Symphony Desktop is not connected, i.e. in Standalone mode, tap to set the system               
sample rate. 

4. Update - Check and update Touch Screen Control. 
5. Reset - Reset Symphony Desktop to its factory default state. 

Shutdown/Display Sleep 
To power off Symphony Desktop, tap and hold the Control knob. 
1. Tap Display Sleep to turn off the touch screen but maintain full audio and Control knob operation. 
2. Tap Shutdown to power off Symphony Desktop. 
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Apogee Desktop Control Software 
The Apogee Desktop Control application provides access to all settings, including System setup, 
direct monitor mixing, hardware DSP and Monitor controller functionality. 

Primary Window 
All features and settings of the Symphony Desktop interface can be controlled from the Primary 
window. It is broken down into several sections: 
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Tool Bar 

 
 

1. Show/hide System Settings sidebar 
2. Clear Meters 
3. Mute Outputs 
4. Open the Hover Help window 

System Settings Sidebar 
Provides System-wide settings that apply to your recording system as a whole. 
 
1. System Status Display - Displays the status of the connected hardware. 

● Green - System is ready: Hardware is connected and recognized, and           
the digital clock is locked to the Clock Source. 

● Red - System not ready. Either the hardware is not connected, or the             
system is not locked to the Clock Source. 

2. Sample Rate - Set Symphony Desktop’s sample rate. In some cases this            
setting may be overridden by software running on the computer (e.g. when            
a DAW session is open). 

3. Peak Hold - Set the time that peak indications are held on the level meters. 
4. Over Hold - Set the time that over indicators are held on the level meters. 
5. Main Output Format - Select the format of the Main ¼” analog outputs: 

● Variable - Choose Variable when connecting directly to powered         
monitors or a power amplifier connected to passive speakers. Output          
level may be set using the Control knob. 

● Fixed - Choose Fixed when connecting to devices that include level           
controls, such as mixing consoles.  

6. Main Output Level ​- Select the line-level reference for the Main output            
jacks: 
● Choose +4dBu when connecting to “pro” gear with inputs at a +4dBu            

nominal level. 
● Choose -10dBV when connecting to “semi-pro”, hi-fi, or musical         

instrument gear with inputs at a -10dBV nominal level. 
7. Keyboard Volume - Choose the Symphony Desktop analog outputs to be           

controlled by the Mac System Preferences > Sound Output volume slider. 
8. Optical Format - Set the digital audio protocol for the optical connectors.            

Match the optical format to that of the connecting device: 
● SPDIF: Optical I/O is formatted in the SPDIF format, which offers 2 channels at a sample rate                 

up to 96kHz. 
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● ADAT/SMUX: Optical I/O is formatted in the ADAT/SMUX format, which offers 8 channels             
44.1/48kHz sample rate and 4 channels at 88.2/96kHz. 

9. Mixer View​ ​- Show/hide the Direct mixers in the Primary window. 
10. Channel FX Recall Preference - When a DAW session is opened which contains linked Channel               

FX plugins, this setting determines which Channel FX - the Direct Mixer plugin or the DAW plugin                 
- overwrites the other. 
● Always Ask - ask to overwrite the Direct Mixer Channel FX. 
● Replace Hardware State - overwrite the Direct Mixer Channel FX with settings from the linked               

DAW FX. 
● Keep Hardware State - overwrite the linked DAW Channel FX with settings from the Direct               

Mixer Channel FX. 
11. Auto disable 48v - Toggle On/Off 

Channel Section 
This portion of the Primary window displays channels for Analog input, Optical input, Playback input, 
and Optical output.  

 

General Settings 
1. Channel View Button - click to show/hide Optical In, Playback and Optical Out channels. The               

Analog In channels are always shown. 
2. Channel Label - Indicates the channel type - Analog In, Optical In Playback, or Optical Out.                

Analog and Optical IN labels are transmitted to your DAW. 

35 



  
Apogee Symphony Desktop ​User’s Guide 

3. Channel Icon - Displays the channel type. Analog IN icons display the input type selected from                
the Analog Level drop-down. 

4. Input Channel Level Meter - displays the digital signal level of the channel. The Analog IN channel                 
levels are post A/D conversion. 

5. Print FX On/Off - Toggle on/off Apogee Channel FX plugins on the Print signal path.  
6. Load Print FX - Load and modify Apogee Channel FX plugins on the Print signal path. 
 
For more detailed information about Apogee Channel FX plugins, see ​here and the Apogee FX User’s                
Guide, included in the Symphony Desktop Installer. 

Analog IN Channels 1-2  

Analog IN channels represent inputs from microphones, instruments and other analog sound sources.  
● Analog inputs are routed to software (DAW) inputs 1-2; 
● Analog inputs are routed to direct monitoring Mixers 1 & 2; 
● Analog inputs may be routed to Optical and Monitor outputs for Standalone operation. 

 
7. Analog Level - choose the analog reference level for Analog inputs 1-2. 

● Choose Mic when connecting microphones or direct boxes to the XLR input. 
● Choose Inst when connecting a guitar or keyboard, or any high impedance (Hi-Z) instrument              

to the 1/4” input (balanced TRS or unbalanced TS).  
● Choose +4dBu when connecting “pro” gear with a nominal +4 dBu output level (such as an                

external mic pre, compressor, or EQ) to the XLR input. 
● Choose -10dBV when connecting “semi-pro”, hi-fi, or musical instrument gear with a nominal             

-10dBV dBu output level to the XLR input. 
8. Preamp - Choose a Mic preamp 

● SD-MP - Symphony mic pre with no emulation processing and a gain range of 0-75 dB. 
● AP-66 - based on a vintage Neve 1066 mic preamp section with a gain range of 20-80 dB. 
● AP-57 - based on a highly modified Ampex tube mic preamp with a gain range of 0-10. 

9. Gain Control - Adjust the gain of the preamp, when Analog Level is set to Mic or Instrument. Gain                   
Control is hidden when Analog Level is set to +4dBu or -10 dBV line input. 

10. Input Settings - Provides options for the various inputs: 
● 48V - Enable 48 volt phantom power on the corresponding Analog In channel. Visible only               

when Analog Level is set to Mic. Most condenser mics require 48 volt phantom power to                
operate. 

● Group - Link the Gain Controls (plus Output Level and Gain Link button when present) for                
each Analog In channel. Visible only when Analog Level is set to Mic or Instrument. Gain                
offsets that exist before grouping channels are preserved. 

● Soft Limit - engage Soft Limit on each analog input. Soft Limit is an analog circuit that begins                  
to attenuate transient peaks at a threshold of -4dBfs, replicating the transient softening of              
analog tape. 

● Polarity Invert - Invert the polarity of the analog input signal. When a single sound source is                 
picked up with 2 transducers, inverting the polarity of one transducer results in a fuller sound.                
For example, if a drum is captured with a mic on each drumhead, inverting the polarity of one                  
mic results in a fuller sound with more low end. The same principle applies when capturing an                 
electric instrument with a miked amp and a direct injection feed. 
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Optical IN Channels 

11. Optical IN channels represent digital inputs from external digital audio devices like standalone mic              
preamp expanders, digitally connected synths, and others. 
● Optical inputs are routed to software (DAW) inputs 3-10, depending on the Optical Format              

setting; 
● Optical inputs are routed to direct monitoring Mixers 1 & 2; 
● Optical inputs may be routed to Optical and Monitor outputs for Standalone operation. 

 

 

Playback Channels 
1. Playback channels represent the playback signal from your audio software (DAW) outputs. 

● Playback channels are routed to direct monitoring Mixers 1 & 2 for using when Direct               
monitoring. 

● Playback channels may be selected as the source for Monitor outputs when software             
monitoring. 

● Playback channels may be selected as the source for Optical outputs. 

Optical Output Channels 
2. Optical output channels represent digital outputs to be connected to external digital audio devices.              

The audio source for the channel is selected in the Routing dropdown menu: 
● Playbacks - route the selected stereo Playback signal from audio software to the Optical              

output. 
● Mixers - route the stereo signal from the selected mixer to the Optical output. 
● HW Inputs - route the selected mono or stereo signal from the selected hardware input(s) to                

the Optical output. 
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Mixer Section 
The mixer section provides two independent mixers for blending Analog, Optical and Playback inputs. 

● Route mixer outputs to Main and headphone outputs for low latency direct monitoring while 
recording; 

● Route mixer outputs directly to audio software inputs; 
● Route mixer outputs to Optical for standalone mixing. 

 

 
 
1. Mixer View - toggle the faders, pan controls and Mute/Solo buttons between two independent               

mixers, Mixer 1 and Mixer 2. 
2. Enable Apogee FX processing in the Monitor path (through the Mixer). 
3. Load Monitor FX - Load and modify Channel FX plugins on the Monitor signal path. For more                 

detailed information about Channel FX plugins, see ​here​ and the Apogee FX User’s Guide. 
4. Channel Pan Control - Set the left-right placement of the channel signal in the mixer stereo                

output. 
● Option-click to reset the pan to center (0) 
● Option+Command-click to set all pans in that mixer to center (0). 

5. Channel Fader - Set the level of the channel signal in the mixer stereo output. 
● Option-click to reset the fader to 0dB. 

6. Channel Mute button - Mute the signal to the mixer stereo output.  
● Command-click to mute all channels 

7. Channel Solo button - Solo the channel - all other channels are muted (unless their Solo button is                  
engaged). 
● Command-click to solo all channels. 
● Control-click the Solo button to engage Solo-Safe mode, where the channel remains unmuted             

regardless of the Solo status of other channels.  
8. Assign to SW Inputs 

● Assign the output of the Mixer to a stereo pair of software inputs. This overrides the default                 
hardware input routing.  

9. Mix Master Output Fader - Set the output level of the Mixer. 
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Monitor/Output Section 
In the Monitor/Output Section, select the signals to be routed to the Main and Headphone outputs,                
then control their volume. Output Level Meters display the presence of signal at the outputs, useful as                 
a diagnostic tool. 
 
1. Output Level Meters - Displays the level of the HP1, HP2 or Main outputs’              

digital source. 
 
The following settings are available for the Main, HP1 and HP2 outputs: 
 
2. Source - choose the signal source for the output (Main, HP1 or HP2). 

● SW Playback - route the selected stereo Playback signal from audio           
software to the HP output. 

● Direct Mixers - route the stereo signal from the selected mixer to the             
HP output. 

● HW:Inputs - route the selected mono or stereo signal from the selected            
hardware input(s) to the HP output. 

3. Mute - mute the output 
4. Dim - dim (reduce) the  output by 15 dB; 
5. Sum to Mono - Collapse left and right signals to mono at the output. This               

combined signal is sent through both Left and Right Outputs and is useful             
for verifying the mono-compatibility of a stereo mix. 

6. Output Level Control - Set the listening level of the output. 
 

 

 

  

40 



  
Apogee Symphony Desktop ​User’s Guide 

 

Menu Bar Menus 

 Desktop Control Menu 

 
 
About Symphony Desktop  Control​ - Choose this menu item to display version information  
for all hardware connected and software elements installed on your Mac. 
Hide Symphony Desktop Control​ - Choose this menu item to hide the Maestro application 
Hide Others​ - Choose this menu item to hide all other open applications 
Show All​ - If any open applications have been hidden, choose this menu  
item to reveal all open applications 
Quit Symphony Desktop Control​ - Choose this menu item to quit Symphony Desktop Control 

File Menu 

 
 
Open Snapshot​ - Choose this menu item to open a user-saved snapshot template file on your 
computer. 
Open Snapshot Template​ - Choose this menu item to open the Snapshot Template Chooser 
window. 
Save​ - Choose this menu item to save a user-customized Snapshot file to a location on your 
computer. 
Save As​ - Choose this menu item to save a customized Snapshot file in a new name or new location 
on your computer. 
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View Menu 

 
 
System Settings​ - Choose this menu item to open the System Settings sidebar 
Enter Full Screen​ - Choose this menu item to expand Element Control to fill the display screen. 

Window Menu 
 
Selecting an item in the ​Window Menu​ switches to a view of that selection. 
 

Help Menu 
 
Use the ​Search​ Field to search for a specific menu item. 
Symphony Desktop Support Online​ - Select this menu item to be taken to the Apogee website’s 
Support page for Symphony Desktop. 
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Choose Your Symphony Desktop Workflows 
In the previous sections of this User’s Guide, the individual components of Symphony Desktop have 
been described in detail. This section describes how these components work together to form a 
sophisticated and efficient audio production environment. 
 
All of us - producers, engineers and artists - have their preferences when recording and mixing, so 
Symphony Desktop offers a wide variety of compelling workflow options. 

A Glossary of Important Workflow Concepts 
With a better understanding of some important workflow concepts, you’ll get the most from your 
Symphony Desktop. 
 
Latency​ - If you’ve done any recording at all with your computer or iPad, you’ve probably 
encountered that annoying delay that makes recording your performance difficult - it’s like you’re 
trying to record over a transatlantic phone call - that’s latency! 
 
What is latency and why do you have to deal with it? Well, it starts with the fundamental process of 
digital audio - to convert audio waveforms to numbers for editing, processing, mixing and more, then 
convert numbers back into audio waveforms for listening. At each stage of your digital audio system - 
analog to digital conversion, recording & playback in your audio software, plugin processing - 
computations are performed on the digital audio that require time. Add up the total time from 
microphone input to headphone output, and the delay can significantly distract a performer as they 
record. 
 
Buffer, aka IO Buffer, H/W Buffer​ - Most Digital Audio Workstation (DAW) software applications 
have a buffer setting, which is potentially the largest source of latency in your system. The buffer 
setting offers a range from 32 to 2048 samples* to specify the amount of time the app spends to pass 
audio from the hardware interface, record it, process it through plugins and mixing, and finally pass it 
back to the interface for listening. Why wouldn’t you set the buffer to the lowest time, 32 samples? 
Then you’d get the lowest latency!  
 
At the lowest setting, you’re giving the DAW the least amount of processing time. As your session 
grows and you add tracks, plugins and virtual instruments, the DAW won’t have enough time to 
complete the processing before the allotted time, and you’ll get clicks, pops and other symptoms of a 
DAW application under stress.  
 
* Buffer settings may vary by DAW and sample rate.  

43 



  
Apogee Symphony Desktop ​User’s Guide 

 
 
Thus, the Buffer setting is always a compromise between lower latency and more processing power. 
 

 
 
Monitoring​ - One of the fundamental workflow choices you’ll make is input monitoring -  that is, how 
performers hear themselves while recording. Symphony Desktop offers two monitoring workflows, 
Software monitoring and Direct monitoring, which are described ​below​ in greater detail. 
 
Native DSP Processing​ - When you open and run plugins in your DAW software, they use your 
computer’s native CPU processing power to perform the required DSP, and are said to be ​native 
plugins. If you’ve set the DAW Buffer to it’s maximum setting, you can run virtually thousands of 
Apogee plugins from a reasonably recent computer - there’s really a lot of native DSP processing 
power available from your computer! 
 
Hardware DSP Processing​ - Even though you can open thousands of plugins running natively on 
your computer, there are a few instances where you need hardware DSP processing on-board your 
audio interface. 

● To fulfill the requirements of Direct monitoring, your audio interface needs hardware DSP for 
the Direct monitoring mixer and plugins; 

● Hardware DSP can process an interface input before it’s sent to your DAW, so you can sculpt 
your sound and record the results. 
 

Apogee Ensemble Thunderbolt, Element Series and Symphony Desktop all offer hardware DSP 
on-board. 
 
Ideally, your plugins can run both as a native plugin in your DAW and as a hardware plugin in your 
audio interface’s Direct monitoring mixer. The Apogee Channel FX plugin is one of the very few that 
can! 
 
Apogee Channel FX Plugin​ - when referred to in this User’s Guide, the Channel FX  
 
Apogee FX Plugin​ - the collection of Apogee plugins that can be opened in the Channel FX plugin 
 
Print FX​ - the term “Print FX” or “printing” is used in this guide to specify DSP processing that is 
“destructive”, or permanently applied to the audio file being processed. For example, when EQ 
processing is “printed”, it becomes a permanent and irreversible characteristic of the audio file. 
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Monitor FX​ - in contrast to Print FX, Monitor FX are on channel playback, and are thus 
“non-destructive” - you can always change your mind. As you become more confident with plugin 
processing, you may choose to print some effects while monitoring through others. 
 
DAW (Audio Software)​ - The digital audio workstation, or DAW, is a specific type of audio software 
that offers sophisticated functionality, including the ability to choose an audio interface independently 
of the OS (operating system), manage multiple channels of input/output, support software or direct 
monitoring, support software plugins, and offers adjustable throughput latency. 
 
Many software applications include audio functionality but don’t offer the critical functionality for 
completely supporting Symphony Desktop workflows. Nevertheless, these apps can work with 
Symphony Desktop when the OS is configured to use Symphony Desktop for audio input/output, as 
described ​here​. 
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Monitoring Workflows 
The two basic monitoring workflows, Software monitoring and Direct monitoring, are described below.  

Software Monitoring 
When your system is set up for Software monitoring, the audio that the performer hears is routed 
through the DAW, including plugins and mixers, and thus incurs the maximum latency of the system, 
as shown below.  
 

 
 

● Pros - This is the simplest monitoring workflow, where most settings are made in the DAW 
window. 

● Cons - It’s necessary to set the DAW IO Buffer setting to a compromise between lower latency 
and maximum CPU plugin processing - the lower the latency, the fewer native plugins may be 
run.  

 
If you have a powerful computer and your sessions use a moderate amount of plugin processing, you 
may be able to find a Buffer setting that’s low enough that latency isn’t a problem but high enough 
that processing is completed without issues.  
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Direct Monitoring 
Direct Monitoring, aka Low Latency Mixing​ - When the processing demands of your session 
require a higher Buffer setting that causes disruptive latency, Direct monitoring lets performers hear 
themselves through a separate mixer running on hardware DSP and controlled in Desktop Control 
software. The Direct mixer avoids the latency-inducing round trip through the DAW. To avoid double 
monitoring, the DAW must be configured so incoming audio to be recorded is NOT monitored through 
the DAW. 
 

 
 

● Pros - Low latency and maximum plugin power - the DAW IO Buffer may be set to its 
maximum value for the greatest number of native plugins without an effect on latency. Latency 
remains virtually non-existent through the direct monitoring mixer. 

● Cons - With many audio interface systems, it’s necessary to toggle between your DAW 
window and a separate direct monitoring mixer app. Adding non-destructive plugins while 
Direct monitoring can become unwieldy. Apogee’s proprietary DualPath monitoring workflow, 
described ​here​, addresses these disadvantages, so you benefit from the advantages without 
suffering the disadvantages. 
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Plugin Processing Workflows 
Symphony Desktop also includes flexible and powerful onboard DSP processing that supports a wide 
range of innovative workflows - 1) Apogee Alloy mic preamp emulation; 2) Print FX; 3) Monitor FX 
(DualPath Monitoring); and 4) Native operation.  
 
Plugin Processing workflows are independent of your monitoring workflow, with the exception of 
DualPath monitoring, which is Apogee’s revolutionary approach to Direct monitoring with plugins. 

Apogee Alloy Mic Preamp Emulation 
Apogee Alloy mic preamp emulation employs circuitry found in Symphony Desktop’s Analog inputs 
plus onboard hardware DSP to bring the warmth and character of classic mic preamps to your 
recordings. 
 
The analog circuitry is a key component of the emulation processing, so mic pre emulation is 
available only on Analog In 1 & 2  mic, line and instrument inputs.  
 
Mic preamp emulation is inserted into the signal path before the direct monitoring mixer and the 
“send” to your DAW, as shown below. Emulation processing is printed, i.e. it permanently modifies the 
audio signal, regardless of your monitoring workflow (Software or Direct monitoring). Of course, a 
hardware mic preamp would also permanently change the audio as well! 
 

 
 
To apply Alloy mic preamp emulation, open the Channel FX on the DAW channel(s) you’re recording 
on. Set the Channel Link setting to match the DAW channel input setting as described ​here​ - now the 
Preamp, Print FX and Monitor FX tabs appear at the top of the plugin. Click Preamp and choose your 
preferred emulation.  
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Print FX 
With Print FX, you can shape your sound as you record it using up to 6 Apogee FX EQ, compression 
and saturation plugins running on Symphony Desktop hardware DSP. 
 
Print FX processing may be applied to analog and optical inputs. 
 
Print FX plugins are inserted in the signal path before the direct monitoring mixer and the “send” to 
your DAW, as shown below. Like mic preamp emulation, Print FX processing permanently modifies 
the audio signal regardless of your monitoring workflow (Software or Direct monitoring). 
 

 
 
To apply Print FX processing, open the Channel FX on the DAW channel(s) you’re recording on. Set 
the Channel Link setting to match the DAW channel input setting as described ​here​ - now the 
Preamp, Print FX and Monitor FX tabs appear at the top of the plugin. Click the Print FX tab, then 
load up to 6 Apogee FX plugins. 
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Monitor FX & DualPath Monitoring 
With Monitor FX and DualPath monitoring, users experience workflow benefits that have previously 
only been available with Avid Pro Tools HD - 1) very low latency, even when the DAW IO Buffer size 
is high 2) simple, non-destructive plugin workflow - open a single plugin in your DAW that processes 
monitoring and playback 3) control from a single app window - your DAW. 
 
When you open Monitor FX plugins in a  DAW Channel FX plugin and set Channel Link, the plugins 
are actually inserted in two ​different​ signal paths -  1) in the DAW Playback signal path and 2) before 
the direct monitoring mixer but ​after​ the “send” to your DAW, as shown below. 
 
When recording, the performer hears himself through Monitor FX running on hardware DSP; 
playback, on the other hand, is heard through Monitor FX running natively in your DAW. Most 
importantly, the two plugins are control-linked, so settings made in one Channel FX plugin are 
mirrored to the other Channel FX plugin.  
 
All this happens automatically and transparently when you open the Channel FX plugin in your DAW 
and link it to a hardware input. We call this revolutionary workflow ​DualPath Monitoring​. 
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Monitor FX & Software Monitoring 
If you’ve configured your system for Software monitoring, you can still benefit from Monitor FX, even 
when Symphony Desktop isn’t connected to your computer. Plugins opened in the Monitor FX tab in 
your DAW are powered natively by your computer’s CPU, so they work even when you’re using 
Built-In headphone outputs or other audio hardware. 
 

 
 
Of course, all Apogee FX plugins may be run directly in your DAW, without opening them in the 
Channel FX plugin. These plugins are powered natively by your computer’s CPU, so they work even 
when you’re using Built-In headphone outputs or other audio hardware. 
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Using the Apogee Channel FX Plugin 
The Apogee Channel FX plugin provides access to all Symphony Desktop DSP processing, and 
includes two unique capabilities to unlock the wide range of processing workflows: 
 
● The Channel FX plugin can be opened both in the Desktop Control app (where plugins run on 

Apogee hardware DSP) and natively in your DAW (where the plugins run on your computer’s 
CPU). This means that DSP processing may be applied at several points in the typical 
overdubbing signal path: 

 

 
 

1. Apogee Alloy Mic Preamp Emulation (including Analog In settings), processed in hardware 
DSP. 

2. Print FX - Up to 6 Apogee FX plugins, processed in Hardware DSP. 
3. Direct Mixer Monitor FX - Up to 6 Apogee FX plugins, processed in Hardware DSP. 
4. DAW Monitor FX - Up to 6 Apogee FX plugins, processed in Native (computer) CPU. 

 
● When the DAW Channel FX plugin is linked (see 5 above) to a hardware input, then the entire 

range of hardware DSP and native processing may be controlled from ​either ​Channel FX - the 
plugins are mirrored. Regardless of where Apogee processing is applied in the signal chain - at 
the hardware analog inputs, the direct monitor mixer or in your DAW running natively - settings 
may be controlled from the Channel FX plugin in your DAW. There’s no need to open the Channel 
FX plugin in Desktop Control in the vast majority of circumstances.  
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To set up the Channel FX plugin, open it in your DAW and link it to a hardware input: 
 
1. Match the Channel Link setting to the DAW Input dropdown list setting 
2. Once linked, all Analog IN 1 hardware controls, including Analog Level, Gain, Input settings, 

Direct Mixer Channel fader and pan may be controlled from the Channel FX plugin. 
3. Mic preamp emulation selection and settings may be made from the Preamp tab. 
4. Apogee FX plugin selection and settings to be permanently “printed” with the recorded audio track 

may be made from the Print FX tab. 
5. Apogee FX plugin selection and settings to be inserted in ​both​ the direct monitoring signal path 

and​ the DAW playback path may be made from the Monitor FX tab (see Monitor FX & DualPath 
Monitoring ​here​). 
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Additional Workflows 

Mix Inputs Before Recording 
You can use the Symphony Desktop Mixer to mix hardware inputs and record the mixed output: 1) 
use two mics to capture an instrument and record a blend to one DAW track; 2) pan one input to the 
center of a stereo output for audio apps without panning functionality.  
 

 
 
In this workflow, Direct Mixer 1 is used to mix hardware inputs which are then routed to DAW channel 
inputs. Direct Mixer 2 is used for Direct monitoring, to mix hardware inputs with Playback outputs from 
the DAW. It looks complicated, but once configured it’s pretty straightforward. 
 
CAUTION - If Mixer 1 Playback inputs are active, you may create a feedback loop that results in a 
loud and potentially damaging oscillation. MUTE the Mixer’s Playback inputs. 
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Configuring Your DAW 
Find below detailed information to configure Symphony Desktop with popular DAWs: 
● Configure the DAW to use Symphony Desktop 
● Configure the DAW for Direct or Software monitoring 
● Access Symphony Desktop inputs & outputs in the DAW 
● Additional DAW-specific notes 

Apple Logic Pro 
To configure Apple Logic Pro to use Symphony Desktop: 
 
1. In the Logic Pro menu bar, choose Logic Pro > 

Preferences > Audio in the menu bar, then click the 
Device tab. 

2. Check the Core Audio checkbox; set Output Device and 
Input Device to Symphony Desktop. 

3. Set I/O Buffer Size to 128 or higher. 
4. Click Apply. 

 
 
 
 
 
 
 
To configure Logic Pro for Direct or Software Monitoring Workflow: 
 
1. In the Logic Pro menu bar, choose Logic Pro > 

Preferences > Audio, then click the General tab. 
2. Check the Software Monitoring checkbox​ regardless​ of 

Software or Direct monitoring. 
3. In Logic Pro, the monitor setting is configurable for each 

channel. 
● On the Logic channel strip, click the Direct button to 

engage Direct monitoring.  
● For Software monitoring, leave the Direct button off. 

4. On the touch screen System Settings Page 1 or in 
Desktop Control, set Main and Headphone Sources to 
Playback 1-2 ​regardless​ of Software or Direct monitoring. 

 
 
 
 
To access Symphony Desktop inputs & outputs in Logic Pro: 
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1. From the Logic Pro menu bar, choose Mix > I/O Labels. 
2. Choose the Provided by Driver labels by clicking on the first label, dragging your mouse down 

until all Symphony Desktop labels are highlighted, then unclick. 
3. Close the I/O labels window. 
4. Select Symphony Desktop inputs and outputs in any Logic Pro Channel Strip. 
 
 
Direct Monitoring with Apogee FX plugins - Logic Pro and Symphony Desktop: 
 
Thanks to the proprietary integration between Symphony Desktop and Logic Pro, Direct monitoring 
with Apogee FX plugins is incredibly simple. 
 
In the Logic channel strip, select the desired Symphony Desktop Input(s) 
and Output. 
1. Click the Direct button to engage Direct monitoring between the 

channel’s Input and Output, with no other settings required. If you’re 
experiencing significant latency, click the Direct button and it just 
disappears. 

2. There’s no separate Direct mixer to adjust - the channel strip fader and 
pan control both the direct monitoring and playback level and pan 
transparently.  

3. To add reverb, create a channel strip bus and instantiate a reverb like 
Clearmountain’s Spaces on the automatically created Aux channel strip. 

4. To add Apogee DSP processing like Alloy mic preamp emulation and 
Channel FX plugins, open an Channel FX plugin in the channel strip 
and link it to the hardware input as described ​here​. 
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Avid Pro Tools 
To configure Avid Pro Tools to use Symphony Desktop: 
 
1. Open Pro Tools, then choose Setup > Playback 

Engine in the menu bar.  
2. Set Playback Engine to Symphony Desktop. 
3. Set H/W Buffer Size to 128 to start, adjust for 

lower latency or more plugin power. 
 
 
 
 
 
 
 
 
 
 
 
To configure Pro Tools for Direct or Software Monitoring Workflow: 
 
1. In the Pro Tools menu bar, set Options > Low Latency Monitoring. 

● Uncheck Low Latency Monitoring for Software monitoring. 
● Check Low Latency Monitoring for Direct monitoring. 

2. In  Desktop Control, set Mixer View in the System Settings column. 
● Set to Off for Software monitoring. 
● Set to On for Direct monitoring. 

3. On the touch screen System Settings Page 1 or in Desktop Control, 
set Main and Headphone Sources. 
● Set to Playback 1-2 for Software monitoring. 
● Set to Mixer 1 for Direct monitoring. 

 
To set channel Input & Output list labels:  
 
1. In the Pro Tools menu bar, choose Setup > I/O. 
2. In the IO Setup window, click the Input tab. 
3. Select all inputs in the Name column, then click Delete Path. Then, 

click Default to reset the Names to Desktop defaults. 
4. Repeat in the Output and Bus tabs. 
 
 
Pro Tools Preference Setting 
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1. To use native reverb while Direct monitoring, choose Pro Tools > Preferences to open the 
Preferences window; click the Mixing tab, then check “Allow Sends to persist during LLM” under 
Setup.  

2. When checked, Pro Tools channels behave in the following manner that’s crucial to the DualPath 
workflow and other operations of the Channel FX plugin. 
● When Record or Input is activated on the channel, the plugin interface remains active 

including level meters. 
● Bus sends remain active, so the channel’s input signal may be sent to native reverbs even 

though the channel’s input is not routed to the session Master output (because Low Latency 
has been checked). 
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Ableton Live 
To configure Ableton Live to use Symphony Desktop: 
 
1. In the Live menu bar, choose Live > 

Preferences and click the Audio tab. 
2. Mac - set Driver Type to CoreAudio; 

Windows - set Driver Type to Apogee 
ASIO Driver. 

3. Set Audio Input Device and Audio 
Output Device to Symphony Desktop. 

4. Set Buffer Size to 128 Samples to start, 
adjust for lower latency or more plugin 
power. 

 
 
 
To configure Ableton Live for Direct or 
Software Monitoring Workflow: 
 
1. Monitor settings in Ableton Live are 

configured for each channel individually. 
2. In the Ableton menu bar, choose View 

and verify that In/Out is checked. 
3. In each channel, set Monitor to Auto for 

Software monitoring or Off for Direct 
monitoring. 

4. On the touch screen System Settings 
Page 1 or in Desktop Control, set Main 
and Headphone Sources. 
● Set to Playback 1-2 for Software 

monitoring. 
● Set to Mixer 1 for Direct monitoring. 
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To set channel Input & Output list labels:  
 
● Choose Live > Preferences and click the 

Audio tab. 
● Under Audio Device, click the Input 

Config and Output Config buttons. 
● Activate inputs & outputs by clicking the 

numbered buttons. Once activated, 
enter your preferred label, i.e. Analog IN 
1, Playback 1-2. 

 
 
Additional Notes 
 
When using the Channel FX plugin linked to a hardware input, plugin metering is only displayed 
during playback, when Ableton channel Monitor is set to Off.  
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Troubleshooting 
 
For more information 
 

● Apogee KnowledgeBase and FAQs 
● Informational Videos 
● Apogee Product Registration 
● How to contact Apogee Technical Support 

 
Please visit: 
www.apogeedigital.com/support 
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Specifications 
System Requirements 

Computer 
● MacOS 10.13 or greater 
● Windows 10 Anniversary update or later 
● iOS 13 or greater 
● Memory: 4GB RAM minimum, 8GB 

recommended 
● Connection: Any available USB 2 or 3 

port 
● Power: DC Power supply included 

 

Compatible Software: 
● All major DAW applications on Mac, 

Windows 10 and iOS 
● Recommended apps: Logic Pro, Pro 

Tools, Ableton Live, Garageband, 
MainStage, Final Cut Pro, Digital 
Performer, Studio One, Cubase and 
Nuendo, FL Studio, Reaper. 
 

 

Preamps, Inputs, and Outputs 

Mic Preamps 

Gain: Up to 75 dB and advanced stepped gain circuit design 
Selectable 48v phantom power, Soft Limit and polarity invert 
EIN: 129dB (un-weighted) @ 60dB, 150 Ohm input 
Max input level: +20dBu 
Input impedance: 150 - 4K Ohm (default) 
Max Hi-Z input level: 14dBu 
Hi-Z input impedance: 220k/470k/>20M Ohm 

A/D Conversion: 

Max input level (+4dBu ref/Mic): +20dBu 
Max input level (-10dBV ref): +6dBV 
Input impedance: 4KOhm 
Freq resp 10 Hz -20Khz: > +/-0.2dB (@44.1Khz) 
Rel. THD + N: -113dB 
Dyn. Range: 123dB (A-weighted) 

D/A Conversion: 

Max output level (+4dBu ref): +20dBu 
Max output level (-10dBV ref): +6dBV 
Line output impedance: 50 Ohm 
Freq resp 10Hz -20 Khz: > +/- 0.05dB (@44.1Khz) 
Rel. THD+N : -114dB 
Dyn Range: 129dB (A-weighted) 
Headphone Max output level: 

● 520mW into 30 Ohm 
● 90mW into 600 Ohm 

Headphone Rel THD+N: -111 dB with 600 Ohm load 
Headphone Dyn Range: 128dB (A-weighted) 
Headphone output impedance <0.5 Ohm 

Weights and Dimensions 
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Warranty Information and Legal Notices 
 
APOGEE ELECTRONICS CORPORATION warrants this product to be free of defects in material and 
manufacture under normal use for a period of 12 months. The term of this warranty begins on the 
date of sale to the purchaser from an authorized Apogee dealer (proof of purchase in the form of a 
receipt may be required). Units returned for warranty repair to Apogee or an authorized Apogee 
warranty repair facility will be repaired or replaced with a functional equivalent product that is new or 
refurbished at the manufacturer’s option, free of charge. Please note this guarantee may be subject to 
other conditions as dictated by the customer’s legal warranty rights under the applicable national 
legislation governing the sale of consumer goods. 
 
Apogee reserves the right to change or improve design at any time without prior notification. Design 
changes are not implemented retroactively, and the incorporation of design changes into future units 
does not imply the availability of an upgrade to existing units. This warranty is void if Apogee 
determines, in its sole business judgment, the defect to be the result of abuse, neglect, alteration or 
attempted repair by unauthorized personnel. The buyer acknowledges and agrees that in no event 
shall the company be held liable for any special, indirect, incidental or consequential damages, or for 
injury, loss or damage sustained by any person or property, that may result from this product failing to 
operate correctly at any time. 
 
Warranty details are subject to change. For the latest warranty information please visit 
www.apogeedigital.com​. 

Declarations of Conformity 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions:  
(1) This device may not cause harmful interference and (2) This device must accept any interference 
received, including interference that may cause undesired operation. This equipment has been tested 
and found to comply with the limits of a Class B digital device, pursuant to Part 15 of the FCC Rules.  
 
CAUTION: Changes or modifications not expressly approved by Apogee Electronics 
Corporation compliance could void the user’s authority to operate the equipment. 
 
Rating: 5V 400mA USB 2.0 
 
Industry Canada Notice 
This Class B digital apparatus meets all requirements of the Canadian  
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Interference-Causing Equipment Regulations. Cet appareil numérique de la classe B respecte toutes 
les exigences du Règlement sur le matérial brouilleur du Canada. 
 
Declaration of Conformity – CE 
Apogee Electronics Corporation hereby declares that the product, Symphony Desktop, to which this 
declaration relates, is in material conformity with the following standards or other normative 
documents: 
  
(EN50081-1/EN55022; 1995) and (EN50082-1/IEC 801-2, 3, 4; 1992)  
following the provisions of: (73/23/EEC – Low Voltage Directive)and (89/336/EEC – EMC Directive) 
 
Declaration of Conformity – CE 
Apogee Electronics Corporation hereby declares that the product, Symphony Desktop, to which this 
declaration relates, is in material conformity with the following standards or other normative 
documents: 
  
 
 
(EN50081-1/EN55022; 1995) and (EN50082-1/IEC 801-2, 3, 4; 1992)  
following the provisions of: (73/23/EEC – Low Voltage Directive) 
and (89/336/EEC – EMC Directive)  
 
Declaration of Conformity – Japan Apogee Electronics Corporation hereby declares that Symphony 
Desktop, to which this declaration relates, is in material conformity with the VCCI Class A standard. 
 
Declaration of Conformity – Australia 
Apogee Electronics Corporation hereby declares that Symphony Desktop is in material conformity 
with AN/NZS standard requirements. 
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